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About this Manual
P/N: 01.54.455405

Version: 2.4

MPN: 01.54.455405024

Release Date: Sep, 2022

© Copyright EDAN INSTRUMENTS, INC. 2011-2022. All rights reserved.

Statement
This manual will help you understand the operation and maintenance of the product
better. It is reminded that the product shall be used strictly complying with this
manual. User’s operation failing to comply with this manual may result in malfunction
or accident for which Edan Instruments, Inc. (hereinafter called EDAN) can not be
held liable.

EDAN owns the copyrights of this manual. Without prior written consent of EDAN,
any materials contained in this manual shall not be photocopied, reproduced or
translated into other languages.

Materials protected by the copyright law, including but not limited to confidential
information such as technical information and patent information are contained in this
manual, the user shall not disclose such information to any irrelevant third party.

The user shall understand that nothing in this manual grants him, expressly or
implicitly, any right or license to use any of the intellectual properties of EDAN.

EDAN holds the rights to modify, update, and ultimately explain this manual.

Responsibility of the Manufacturer
EDAN only considers itself responsible for any effect on safety, reliability and
performance of the equipment if:

Assembly operations, extensions, re-adjustments, modifications or repairs are
carried out by persons authorized by EDAN, and

The electrical installation of the relevant room complies with national standards, and

The instrument is used in accordance with the instructions for use.

Product Information

Product Name: Ultrasonic Pocket Doppler

Model: SONOTRAX Lite, SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro,
SONOTRAX II, SONOTRAX II Pro, SONOTRAX Vascular
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Terms Used in this Manual
This guide is designed to give key concepts on safety precautions.

WARNING

A WARNING label advises against certain actions or situations that could result in
personal injury or death.

CAUTION

A CAUTION label advises against actions or situations that could damage equipment,
produce inaccurate data, or invalidate a procedure.

NOTE

A NOTE provides useful information regarding a function or a procedure.
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Chapter 1 Safety Guide

NOTE:

This user manual is written to cover the maximum configuration. Therefore, your
model may or may not have some of the parameters and functions described,
depending on what you have ordered.

1.1 Intended Use/Indications for Use

The SONOTRAX Series Ultrasonic Pocket Dopplers (hereinafter called “the Doppler”) are
intended to be used by health care professionals including registered nurses, practical
nurses, midwives, ultrasound technicians, and physician assistants, by prescription from
licensed physicians in hospitals, clinics and private offices.
The 2 MHz and/or 3 MHz waterproof probes are indicated for the detection of fetal heart
rate from early gestation thru delivery and as a general indication of fetal well being.
They can also be used to verify fetal heart viability.

The 4 MHz, 5 MHz and/or 8 MHz waterproof vascular probes are indicated for the
detection of blood flow in veins and arteries for assisting in the detection of peripheral
vascular disease.

1.2 Safety Precautions

This unit is internally powered equipment, and it is an IEC/EN 60601-1 Type B
applied part. Type B protection means that the connection between the
equipment and personnel complies with permitted leakage currents and dielectric
strength of IEC/EN 60601-1.

WARNING and CAUTION messages must be observed. To avoid the possibility of injury,
observe the following precautions during the operation of the device.

WARNING

1 The Doppler is a tool to aid the healthcare professional and should not be used
in place of normal fetal monitoring. It is not intended for treatment.

2 Placement of the ultrasound transducer on the abdomen is critical to obtaining
the fetal heart beat as opposed to maternal heart beat or other abdominal
noise. The user should be trained in proper placement techniques either
through acceptable Ob/Gyn training and individual state accreditation, or as
being prescribed by such a trained clinician and trained in device placement.

3 This device is not explosion-proof and can not be used in the presence of
flammable anaesthetics.

4 The device is not protected against defibrillation.

5 Do not use the device with HF surgical equipment.
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WARNING

6 Only use the probes provided by the manufacturer.

7 We recommend that exposure to ultrasound should be kept as low as
reasonably achievable. This is considered to be good practice and should be
observed at all time.

8 SHOCK HAZARD - Do not attempt to connect or disconnect a power cord with
wet hands. Make certain that your hands are clean and dry before touching a
power cord.

9 Accessory equipment connected to the analog and digital interfaces must be
certified according to the respective IEC/EN standards (e.g. IEC/EN 60950 for
data processing equipment and IEC/EN 60601-1 for medical equipment). If in
doubt, consult our technical service department or your local distributor.

10 Do not heat or throw batteries in fire as this may cause explosion.

11 Do not short-circuit the batteries or install the batteries reversely

12 Do not attempt to charge normal alkaline batteries. They may leak, catch fire or
even explode.

13 Do not solder the leading wire and the battery terminal directly.

14 Do not destroy the battery: Do not pierce the battery with a sharp object such
as a needle; do not hit with a hammer, step on or throw or drop to cause strong
shock; do not disassemble or modify the battery.

15 The battery should be charged, used or stored away from the static electricity.

16 Do not mix the battery with metal objects to avoid short-circuit.

17 Remove the batteries and store them in a cool and dry environment if the
device is not used for a long time.

18 If rechargeable batteries are used, charge them fully before initial use by using
the method introduced in this manual.

19 If the rechargeable batteries are stored alone and not used for a long time, we
recommend that the batteries should be charged at least once every 6 months
to prevent overdischarge.

20 The rechargeable NI-MH batteries and battery pack should be charged by
using the dedicated adapters recommended or supplied by the manufacturer.
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WARNING

21 Replacement of the battery or charging the battery shall be done at least 1.5
meters away from patients.

22 The device shall only be used when the battery cover is closed.

23 If the liquid leak from the battery spills onto your skin or clothes, wash well with
fresh water immediately.

24 If the liquid leak from the battery gets into eyes, do not rub the eyes. Wash
them well with clean water and see a doctor immediately.

25 Keep away from fire immediately when leakage or foul odor is detected.

26 Stop using the battery if abnormal heat, odor, discoloration, deformation or
abnormal condition is detected during use, charge, or storage. Please dispose
it according to the local regulations.

27 Do not immerse, throw, or wet the battery in water/seawater.

28 Batteries have life cycles. The alkaline batteries are intended to be used once.
If the time that the Doppler using NI-MH battery becomes much shorter than
usual, the battery life is at an end. Replace them with those of identical
specifications.

29 Do not connect any equipment or accessories that are not approved by the
manufacturer or that are not IEC 60601-1 approved to the device. The operation
or use of non-approved equipment or accessories with the device is not tested
or supported, and device operation and safety are not guaranteed.

30 Using accessories other than those specified by the manufacturer may result in
increased electromagnetic emissions or decreased electromagnetic immunity
of the device.

31 The device should not be used adjacent to or stacked with other equipment
and that if adjacent or stacked use is necessary, the device should be observed
to verify normal operation in the configuration in which it will be used.

32 The medical electrical equipment needs to be installed and put into service
according to the EMC Information provided in this user manual.

33 Portable and mobile RF communications equipment can affect medical
electrical equipment, refer to section A3.4 Recommended Separation
Distances.

34 Do not service or maintain the device or any accessory which is in use with a
patient.

35 If any serious incident that has occurred in relation to the device， user and/or
patient should report to the manufacturer and the competent authority of the
Member State in which the user and/or patient is established. .
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CAUTION

1 Federal (U.S.) law restricts this device to sale by or on the order of a physician.

2 Refer servicing to qualified personnel.

3 The main unit is designed for continuous operation and is ‘ordinary’. Do not
immerse it in any liquid (i.e. not drip or splash-proof).

4 Keep the device in a clean environment and avoid vibration during storage.

5 Do not sterilize the Doppler with autoclave or gas.

6 Electromagnetic Interference - Ensure that the environment in which the device
is operated is not subject to any source of strong electromagnetic emissions,
such as radio transmitters, mobile telephones, etc.

7 Prior to examination using the Doppler, check for visible damages of the main
unit and the probe that may endanger the patient/operator or machine
performance. If the damage is found, replace them with good ones at once.

8 The following safety checks should be performed once every two years or as
specified in the institution’s test and inspection protocol by a qualified person
who has adequate training, knowledge, and practical experience to perform
these tests.

 Inspect the equipment for mechanical and functional damage.

 Inspect the safety relevant labels for legibility.

 Verify that the device functions properly as described in the instructions for
use.

 Test the pregnant woman’s leakage current according to IEC 60601-1: Limit:
d.c 10 µA, a.c 100 µA.

The leakage current should never exceed the limit. The data should be
recorded in an equipment log. If the device is not functioning properly or fails
any of the above tests, the device has to be repaired.

9 The device and accessories are to be disposed of according to local
regulations after their useful lives. Alternatively, they can be returned to the
dealer or the manufacturer for recycling or proper disposal. Batteries are
hazardous waste. Do NOT dispose them together with house-hold garbage. At
the end of their life hand the batteries over to the applicable collection points
for the recycling of waste batteries. For more detailed information about
recycling of this product or battery, please contact your local Civic Office, or
the shop where you purchased the product.
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1.3 Symbols

No. Symbol Definition

1 CE marking

2

The products marked with this symbol apply to the
European WEEE directive. This symbol Indicates this

equipment contains electrical or electronic

components that must not be disposed of as

unsorted municipal waste, but collected separately.

Contact an authorized representative of the
manufacturer for information for the decommissioning

of your equipment.

3
Caution: Federal (U.S.) law restricts this device to sale
by or on the order of a physician.

4 Operating instructions

5 Caution

6 Current: Direct

7 TYPE B APPLIED PART

8 Part Number

9 SERIAL NUMBER

10 Date of manufacture

11 MANUFACTURER

12
AUTHORISED REPRESENTATIVE IN THE EUROPEAN

COMMUNITY

13 General symbol for recovery/recyclable
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14 Power adapter connector

15 Headphones

16
Refer to User Manual

(Background: Blue; Symbol: White)

17
Warning

(Background: Yellow; Symbol&Outline: Black)

18 This way up

19 Fragile, handle with care

20 Keep dry

21 STACKING LIMIT BY NUMBER

22 HANDLE WITH CARE

23 DO NOT STEP ON

24 Medical device

25 Unique Device Identifier

NOTE:
The user manual is printed in black and white.
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Chapter 2 Doppler and Accessories

2.1 Features

There are seven different models available: SONOTRAX Lite, SONOTRAX Basic,
SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II, SONOTRAX II Pro and
SONOTRAX Vascular.
SONOTRAX Lite and SONOTRAX Vascular are for simple auscultation (intermittent
listening). SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II,
and SONOTRAX II Pro not only detect fetal heart sound; they also display the fetal heart
rate on a LCD screen.

The features of the Dopplers are listed in the following chart:

Model
Function

SONOTRAX
Vascular

SONOTRAX
Lite

SONOTRAX
Basic

SONOTRAX
Basic A

SONOTRAX
Pro

SONOTRAX
II

SONOTRAX
II Pro

LCD Display - - √ √ √ √ √

LCD Backlight - - - √ √ √ √

Mini USB Probe
Socket √ √ √ √ √ √ √

Probe Detecting √ √ √ √ √ √ √

Probe Identifying - - √ √ √ √ √

Audio Play √ √ √ √ √ √ √

Earphone
Socket

√ √ √ √ √ √ √

Volume
Adjustable √ √ √ √ √ √ √

Modes
Switching - - √ √ √ √ √

Audio Recording
and Playing

- - - - √ - √

Powered by
Alkaline
Batteries

√ √ √ √ √ - -

Powered by
Rechargeable
NI-MH Batteries

* * * * * - -

Powered by
NI-MH Battery
Pack

- - - - - √ √

Low Battery
Detecting &
indicating

√ √ √ √ √ √ √

Auto Shutdown - - √ √ √ √ √

Vascular
Examining √ * * * * * *
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√ = configured - = not available * = available

2.2 Main Unit

NOTE:

The pictures and interfaces in this manual are for reference only.

2.2.1 Appearance

Take 2.0 MHz obstetrical probe for example.

Figure 2-1 Front Panel Figure 2-2 Rear Panel

7 8 9 10 11

Figure 2-3 Top Panel Figure 2-4 Left Panel

1 Display Panel 2 POWER Button 3 Speaker

4 Probe Socket 5 Probe Holder 6 Battery Compartment

7 Charge Indicator/

Power Indicator

8 Earphone Socket 9 Charge Socket

10 Volume Control 11 Buttons

1

2

3

4

5

6
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2.2.2 Display Panel

SONOTRAX Lite and SONOTRAX Vascular have a LED in the bottom left corner of its
display panel area. When powered on, the LED turns green. If the LED flashes in green, it
indicates that the probe is disconnected or poorly connected. If the LED flashes in
orange, it indicates that the battery is too low to support working. Change for a new
battery or charge the rechargeable battery in time.
For SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II and
SONOTRAX II Pro, the LCD is shown as follows:

1 2 3 4

5 6 7

Figure 2-5 LCD

Item Screen Element Description

1 FHR Refresh Frequency

2 Working Mode

3 Playing Indicator

4 Recording Indicator

5 Battery Indicator

6 Numeric FHR
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7 Probe Type

2.2.3 Buttons

At most there are three push buttons (MODE, START/STOP and REC/PLAY) and a
volume control button on the main unit of the Doppler. Their primary functions are as
follows:

(1) MODE Button
(Only for SONOTRAX Basic / SONOTRAX Basic A / SONOTRAX Pro / SONOTRAX II /

SONOTRAX II Pro)
Function: Select the working mode.

(2) START/STOP Button
(Only for SONOTRAX Basic / SONOTRAX Basic A / SONOTRAX Pro / SONOTRAX II /
SONOTRAX II Pro)
Function: Start/ stop examining (Mode 3)/Change backlight setting (Mode 4).

(3) REC/PLAY
(Only for SONOTRAX Pro/ SONOTRAX II Pro)
Function: Start/ stop recording or playing fetal heart sound.

(4) Volume Control Indicator
Function: Adjust volume. Rotate the volume gear toward “+” to turn up the volume,

or rotate it toward “-” to turn down the volume.

2.2.4 Socket

The two sockets are located on the top panel of the Doppler.

(1) Earphone socket : for outputting audio signals, the earphone or line-in cable
connects to the Doppler via this socket.

(2) Charge socket : for charging the NI-MH battery pack, the dedicated power
adapter connects to the Doppler via this socket. (For SONOTRAX II and SONOTRAX II
Pro only)

NOTE:
Accessory equipment connected to the analog and digital interfaces must be
certified according to the respective IEC/EN standards (e.g. IEC/EN 60950 for data
processing equipment and IEC/EN 60601-1 for medical equipment). If in doubt,
consult our technical service department or your local distributor.
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2.2.5 Probe Socket

The probe socket is as shown in figure 2-6.

Figure 2-6 Probe socket

Connect the 2.0 MHz/3.0 MHz obstetrical probes or 4.0 MHz/5.0 MHz/8.0 MHz vascular
probes supplied by the manufacturer to the Doppler through the probe socket.

CAUTION

1 Do not try to connect any other plug to the probe socket except the plug of the
probes mentioned above.

2 Do not stretch the probe cable for more than two meters long.

2.2.6 Batteries

SONOTRAX Lite, SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro and
SONOTRAX Vascular are powered either by two alkaline batteries or two rechargeable
NI-MH batteries.
SONOTRAX II and SONOTRAX II Pro are powered by a NI-MH battery pack supplied
by the manufacturer.

Jack Definition
1 Power Supply

2 Signal

3 Probe Coding 1

4 Probe Coding 2

5 GND

6 (Shell) GND
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Alkaline Battery Rechargeable NI-MH Battery NI-MH Battery Pack

Figure 2-7 Batteries

NOTE:
The alkaline battery and rechargeable NI-MH battery can be replaced by those of
identical specifications purchased locally.

Alkaline battery: LR6, AA, 1.5 V.
Rechargeable NI-MH battery: AA, R6, 1.2 V.

2.3 Probes

2.3.1 Waterproof Obstetrical Probes

The 2 MHz/3 MHz waterproof obstetrical probes can be connected to the main unit for
fetal heart examining.
The 2 MHz obstetrical probe features in deep penetration and is designed for use during
the third trimester pregnancy. The 3 MHz obstetrical probe features in high sensitivity
and is designed for use as early as 10 weeks.

Figure 2-8 2/3 MHz obstetrical probe

The main information on the probe is as follows:
2.0 MHz/3.0 MHz: The central frequency is 2.0 MHz/3.0 MHz.
Waterproof: The probe is waterproof.
IPX8: Water Ingress Protection Code. It indicates that this probe does not get soaked
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under water within 1 meter deep for five hours.

2.3.2 Waterproof Vascular Probes

The 4 MHz/5 MHz/8 MHz waterproof vascular probes can be connected to the main unit
for artery and vein blood flow examining.

Figure 2-9 4/5/8 MHz Vascular Probes
The main information on the probe is as follows:
4.0 MHz/5.0 MHz/8.0 MHz: The central frequency is 4.0 MHz/5.0 MHz/8.0 MHz.
Waterproof: The probe is waterproof.
IPX8: Water Ingress Protection Code. It indicates that this probe does not get soaked
under water within 1 meter deep for five hours.
NOTE:
The 5.0 MHz probe can only be applied to SONOTRAX Lite and SONOTRAX
Vascular.
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Chapter 3 Basic Operation

NOTE:

To ensure that the Doppler works properly, please read this chapter and Chapter 1
Safety Guide before operation; follow the steps when connecting all the
components.

3.1 Opening the Package and Checking

Open the package; take out the Doppler and accessories carefully. Keep the package
for possible future transportation or storage. Check the components according to the
packing list.
 Check for any mechanical damage.
 Check all the cables and accessories.
If there is any problem, contact us or your local distributor immediately.

3.2 Installing/Replacing Battery

NOTE:
The batteries of SONOTRAX II and SONOTRAX II Pro are fixed in the battery
compartment cover. Start from step 3 for battery installation.
1) Open the battery compartment.
Turn the Doppler upside down. Hold the main unit with one hand; press the thumb of the
other hand on the cover notch and push it upward and forward. The compartment cover
is open.

Figure 3-1 Opening battery compartment
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2) Install the battery.

Put the alkaline batteries or NI-MH batteries into the battery compartment cover.

CAUTION
The direction of the batteries should comply with the polar mark on the cover.
Reversed connection is forbidden.

Figure 3-2 Putting batteries into the compartment cover

3) Close the compartment.
Put the battery compartment cover back into the compartment, push it forward and
downward until it clicks closed.

Figure 3-3 Closing the battery compartment
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CAUTION

1 If the Doppler is not used for an extended period, take the alkaline/NI-MH
batteries out and store them in a cool and dry environment.

2 Do not remove the NI-MH battery pack frequently after initial installation.

3 If the Doppler is not used for an extended period, charge the NI-MH batteries or
the NI-MH battery pack at least every three months.

3.3 Probe Operation

(1) Taking out the probe
Hold the main unit with one hand. Pinch the probe and pull it outwards using mild force.

Figure 3-4 Taking out the probe
(2) Placing the probe
Hold the main unit with one hand. Pinch the probe and align it with the probe holder.
Push the probe inwards using mild force until it clicks in position.

Figure 3-5 Placing the probe
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CAUTION
Do not take out or place the probe when the Doppler is on. Remember to take out
the probe before switching on the Doppler, and place the probe after switching off
the Doppler.

(3) Replacing the probe
Remove the old probe:
Switch off the Doppler; hold the main unit with one hand and pinch the jacket of the mini
USB socket. Lift the jacket up slightly and pull it out with mild force; take out the probe.

CAUTION
Do not pull the probe cable directly.

Figure 3-6 Removing the probe
Replace it with a new probe:
Put the USB socket of new probe into the probe interface of the Doppler.
NOTE:
Place the temporarily unused probe carefully and avoid falling off, splash or stress,
etc. When the Doppler is not used for a long time, it’s recommended to connect the
probe to the Doppler and keep them safely in the package.

3.4 Switching on

Press the POWER button on the front panel to switch on the Doppler.
If the probe is not connected or poorly connected, the LCD displays a flashing “--- MHz”
sign. You should reconnect the probe properly.
When the probe is well connected, the LCD stops flashing and shows
the probe frequency in the bottom right corner.

3.5 Selecting Working Mode

The Doppler has four working modes. They are:

Mode 1: Real-time FHR Display Mode
Mode 2: Averaged FHR Display Mode
Mode 3: Manual Counting Mode
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Mode 4: Backlight Brightness Setting Mode

Press the button on the left panel, the doppler working mode
switches among these modes, and the working mode is shown in the
top left corner of LCD.

When the doppler is swiched on, it enters mode 1 automatically.

3.6 Enabling or Disabling Backlight

SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II and SONOTRAX II Pro have
backlight. You can enable or disable it.

Keep pressing the button until the working mode on LCD displays 4. Press the

button. The backlight is enabled when the LCD reads “ON”, and it is disabled
when the LCD reads “OFF”.
The setting in this mode is saved automatically after the mode is changed or normal
power-off.

3.7 Switching Off

Press the POWER button on the front panel to switch off the Doppler.
For SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II and
SONOTRAX II Pro, it switches off automatically if there is no input signal or no
operation is performed for 60 seconds.

3.8 Replacing/Charging the Battery

3.8.1 Battery Energy Indication

After switched on, the Doppler gives indication of battery energy.
For SONOTRAX Lite and SONOTRAX Vascular, the LED in the bottom left corner of
the display panel lights up in green. When it flashes in orange, the battery power is low.
For SONOTRA Basic, SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II and
SONOTRAX II Pro, there is a battery symbol in the bottom left corner of LCD. The
panes in it indicate the battery electric energy.

SONOTRA Basic Other Models
The panes disappear gradually with the energy consumption. When the energy is low,
the empty battery symbol flashes. Approximately five minutes later, the Doppler shuts
down automatically.
You should replace the batteries or charge the rechargeable batteries.
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3.8.2 Replacing Alkaline Batteries

CAUTION
Make sure the Doppler is shut down before charging the battery or opening the
battery compartment.

When the alkaline batteries are low in energy, they should be removed from the main
unit, by using the procedures described in section 3.2 Installing/Replacing Battery.
Dispose of them according to local regulations.
New alkaline batteries with identical specifications are required. Install them to the
Doppler as introduced in section 3.2.

WARNING
DO NOT CHARGE THE ALKALINE BATTERY.

3.8.3 Charging the NI-MH Batteries

When the rechargeable NI-MH batteries are low in energy,
1) Take the NI-MH batteries out from the main unit by using the procedures

described in section 3.2 Installing/Replacing Battery.
2) Replace them with new batteries of identical specifications, or charge them with

a NI-MH battery charger that meets the following specifications:
Input: AC 100-240 V, 50 Hz/60 Hz
Output: DC 1.45 V*2, 500 mA
After the batteries are fully charged, install them back to the Doppler.

WARNING
The battery charger should meet the requirements of Standard IEC60950, and it
should be placed outside the patient environment when it's working (1.5 m away
from the patient).

3.8.4 Charging NI-MH Battery Pack

When the NI-MH battery pack is low in energy, charge the battery pack with the
provided power adapter.

1) Put the plug of the power adapter into the charge socket of the Doppler (on the
top panel).

2) Connect the power adapter to a power supply socket. During charging, a battery
sign appears on the LCD with continuous changing energy sign, and the
charging indicator on the Doppler lights up.

3) When the charging indicator goes off, the battery pack is fully charged
(approximately 3 ~ 4 hours are needed). Remove the power adapter plug and the
Doppler is ready for examining again.
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Figure 3-7 Charging NI-MH Battery Pack

The specifications of the provided power adapter are as follows:
Input: AC 100-240 V, 50 Hz/60 Hz, 0.2 A
Output: DC 5 V, 1 A

WARNING
The AC-DC power adapter meets the requirements of Standard IEC60950, and it
should be placed outside the patient environment when it's working (1.5 m away
from the patient). The Doppler is not available for examining during charging.
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Chapter 4 Examining

4.1 FH Examining

Before applying the Doppler for fetal heart (FH) examining, a proper probe should be
chosen. The 2.0 MHz obstetrical probe is optimized for deep penetration and late
pregnancy. The 3.0 MHz obstetrical probe has higher sensitivity and is optimized for
early pregnancy (after 10 weeks gestation).
NOTE:
In some cases, fetal heart beats at 10 weeks gestation can not be detected due to
the maternal physical difference and the operator’s technique.
Perform fetal heart examining using the following procedures:
1) Confirm the fetus’s position by hand.
2) Determine the probable probe location for optimal FHR examining.
3) Take out the probe and switch on the Doppler.
4) Apply a certain amount of coupling gel to the probe faceplate and place the probe

against the abdomen at the predetermined location. Move the probe around or tilt it
until clear and rhythmic heart sound is heard from the headphone or speaker. At the
same time, a numeric FHR is displayed on the LCD (except SONOTRAX Lite).

If the Doppler works in mode 1, the numeric is the real-time heart rate, it changes
continuously.
If the Doppler works in mode 2, the numeric is the average of every 8 heart beats, it
changes slowly.

If the Doppler works in mode 3, press the button once and start counting
immediately, viz. count one at the moment when the button is pressed. The LCD shows

a flashing heart shape symbol and “---”. Press the button again on the 10th count
(after nine beat intervals). The Doppler calculates and displays the average FHR over the
10 beats. This rate value will not disappear until another measurement starts or the
mode is changed.

NOTE:
1 The best quality records will only be obtained if the probe is placed in the

optimum position.
2 Positions with strong placental sounds or umbilical blood flow sound should be

avoided.
3 If the fetus is in the cephalic position and the mother is supine, the clearest

heart sound will normally be found on the midline below the umbilicus. During
examining, the pregnant woman’s prolonged lying in the supine position should
be avoided owing to the possibility of supine hypotension. Sitting up or lateral
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positions are preferable and may be more comfortable.
4 It is impossible to examine FHR unless a fetal heart sound is present. The fetal

pulse can be distinguished from the maternal pulse by feeling the mother’s
pulse during the examination.

5 When applied to the patient, the ultrasound transducer may warm slightly (less
than 4°C (7.2°F) above ambient temperature). When NOT applied, the
ultrasound transducer may warm slightly (less than 4°C (7.2°F) above ambient
temperature).

4.2 FH Sound Recording and Playing

This function is only available with SONOTRAX Pro and SONOTRAX II Pro.
Recording:

In mode 1, 2 or 3, press and hold the button for three seconds, the machine starts

recording, and the LCD reads .

The longest record time is 240 seconds. When the time is up or the button is
pressed again, the Doppler stops recording and returns to the real-time status.
NOTE:
Only the last set of recorded fetal heart sounds is saved in the Doppler. It is
cleared when new sounds are recorded.
Playing:

When the machine is not recording in mode 1, 2 or 3, press the button once, the

machine plays the recorded sound, and the LCD reads .

When the recorded sound comes to the end or the button is pressed again, the
Doppler stops playing and returns to the real-time status.
NOTE:
Observe the LCD, pay attention not to mistake the recorded fetal heart sound for
the real-time sound.

4.3 FH Sound Recording by PC

The signal of fetal heart sound can be transferred to a personal computer (PC) and
recorded by the sound recorder. You can play the recorded sound files, burn them into
CDs or e-mail them to whomever you want.

4.3.1 Recording Sounds

Insert one plug of the special line-in cable supplied by the manufacturer to the audio

input socket (the socket with the symbol “ ”) of the PC, refer to figure 4-1. If the PC
has no audio input socket, insert the plug into the microphone socket (the socket with

the symbol “ ”).
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Audio Input Socket

Figure 4-1 Audio Input Socket on the PC

Turn on PC and run the sound recorder (Click on Start > Programs > Accessories >
Entertainment > Sound Recorder). Refer to figure 4-2.

Figure 4-2 Run the sound recorder
Perform FHR examination with the method described in section 4.1. When the ideal
signal is detected, unplug the earphone (if it’s connected) and insert the other plug of the
audio cable into the earphone socket on the Doppler.

Figure 4-3 Sound Recorder Figure 4-4 Recording
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Click on the start key to start recording, refer to figure 4-3.
You can record 60 seconds each time. When the time is up, click on the start key again
to keep on recording.

Click on the stop key to stop recording, refer to figure 4-4.
Click on File > Save, input the file name, select a folder and click on Save to save the
signals in a “.wav” file.
To start a new recording, click on File > New.

4.3.2 Playing Sound Files

The recorded sounds are saved as waveform (.wav) files in your computer.
You can play the waveform file with the sound recorder. Run the sound recorder, click
on File > Open, search for the folder and select the file, click on Open to load the file,

and then click on the play key .
If you have any other program that supports waveform (.wav) files installed on your PC,
double-click on the file to play it.

4.3.3 Burning CD or Sending in Email

The waveform files saved in your PC are normal audio data files. You can burn them into
CDs or e-mail to whomever you want.

4.3.4 Record Troubleshooting

If there is audio output from the speaker or earphone, but the PC recorder does not have
any input. (The green line recording area has no waveform.) The reason could be:
1. Poor connection of the audio cable between the Doppler and the PC.

- Check the plugs of the cable and re-connect it if any poor connection is detected.
2. The audio cable has been plugged to the wrong socket of the PC, instead of the audio

input socket or the microphone socket.
- Insert the plug to the right socket.

3. The Line in or microphone is muted on PC.
- Change the setting of the PC in these steps:
a) Double-click on the volume symbol in the bottom right corner of your desktop;

b) The volume control menu pops up:
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Figure 4-5 Volume control menu
c) If the line in or/and microphone volume control is/are not shown in the Volume

Control menu, click on Options > Properties, tick Line In and Microphone as
shown in figure 4-6, click on OK:

Figure 4-6 Properties

d) Make sure Line In and Microphone is not mute, click on to exit.
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Figure 4-7 Volume Control
e) Start a new recording.

4.4 Vascular Examining (Optional)

WARNING
The Doppler is not intended for ophthalmic use. Do not use it for examining
ophthalmic vessels, or any other procedures which may cause the ultrasound
beam to pass through the eye.

4 MHz, 5 MHz or 8 MHz vascular probes are to be connected to the Doppler to perform
vascular examination.
Choose the appropriate probe as required. The probe with low frequency has a deeper
penetration depth, while the probe with high frequency has better resolution and wider
detecting range. The 4 MHz vascular probe is optimized for examining blood vessels;
the 5 MHz vascular probe is optimized for examining deeper vessels, and the 8 MHz
vascular probe is optimized for examining surface vessels.
Apply a liberal amount of gel on the site to be examined. Place the probe at a 45º angle
on the skin over the vessel to be examined. Adjust the position of the probe to obtain the
loudest blood flow sound. Refer to figure 4-8 for the probe sites:
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Vertebral Artery (4/5 MHz)

Carotid Artery (4/5/8 MHz) Carotid Artery (4/5/8 MHz)

Subclavian Artery (4/5 MHz)

Subclavian Vein (4/5 MHz)

Jugular Vein (4/5 MHz)

Brachial Artery (8 MHz)

Ulnar Artery (8 MHz)

Radial Artery (8 MHz)

Femoral Artery (4/5 MHz)

Femoral Vein (4/5 MHz)

Popliteal Artery (4/5 MHz)

Great Saphenous Vein (4/5/8 MHz)

Small Saphenous Vein (8 MHz) Posterior Tibial Artery (8 MHz)

Dorsalis Pedis Artery (8 MHz)

Posterior Tibial Vein (8 MHz)

Figure 4-8 Probe sites
For best results, keep the probe as still as possible once the optimum position is found.
Adjust the volume as required. High pitched pulsatile sounds are emitted from arteries
while veins emit a non-pulsatile sound similar to a rushing wind.
Vascular examination only provides audio signals of arteries and veins. The LCD screen
always displays the probe frequency.
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NOTE:
When applied to the patient, the ultrasound transducer may warm slightly (less
than 4°C (7.2°F) above ambient temperature). When NOT applied, the ultrasound
transducer may warm slightly (less than 6°C (10.8°F) above ambient temperature).

4.5 Completing Examining

After examining,
1) Switch off the Doppler.
2) Wipe the remaining gel off the patient and the probe with a clean soft cloth or tissue.
3) Place the probe back to the holder.
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Chapter 5 Maintenance

5.1 Maintenance

You must check that the equipment does not have visible evidence of damage that may
affect the patient and the operator’s safety or the Doppler’s capability before each use.
Pay special attention to the cracks on the probe and the cable before immersing them
into conductive fluid. If the damage is evident, replacement is recommended.
The probe is frangible and must be handled with care.
Wipe the remaining gel after use to prolong the probe life.
The overall check of the Doppler, including safety check and function check, should be
performed by qualified personnel every 12 months, and each time after service. Besides
the above requirements, comply with local regulations on maintenance and
measurement.

5.2 Cleaning

If the main unit or accessory has been in contact with the patient, then cleaning and
disinfection is required after every use. If there has been no patient contact and there is
no visible contamination then daily cleaning and disinfection is appropriate.
The validated cleaning agents for cleaning the main unit and reusable accessories are:
1. Mild near neutral detergent
2. Ethanol (75%)
3. Isopropanol (70%)
Cleaning agents should be applied and removed using a clean, soft, non-abrasive cloth
or paper towel.

5.2.1 Cleaning of the Main Unit

1. Switch off the main unit.
2. Wipe the entire exterior surface, including the screen, of the equipment using a soft

cloth dampened with the cleaning solution thoroughly until no visible contaminants
remain.

3. After cleaning, wipe off the cleaning solution with a fresh cloth or towel dampened
with tap water until no visible cleaning agent remains.

4. Dry the main unit in a ventilated and cool place.

5.2.2 Cleaning of the Probe

1. Disconnect the probe from the main unit.
2. Wear sterile protective gloves to prevent infection.
3. Remove all residual foreign matters from the probe using sterile cloth or paper towel

immediately after examination. For the situation where a protective sheath is used,
the protective sheath should be removed first and discarded.

4. Wipe the surface of probe and cable with a sterile cloth dampened with the cleaning
solution until no visible contaminants remain.

5. After cleaning, wipe off the cleaning solution with a new sterile cloth dampened with
tap water until no visible cleaning agent remains.

6. Wipe off with a dry sterile cloth to remove residual moisture.
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7. Leave the probe to air dry.
8. If the probe is not visually clean at the end of the cleaning steps, please repeat the

cleaning steps through step 4 to step 7.
9. Inspect the probe to ensure that there is no damage. The transducer should be

disposed of properly when any damage is found.

CAUTION
1 Do not use strong solvent, such as acetone.
2 Never use an abrasive such as steel wool or metal polish.
3 The main unit is not waterproof. Do not immerse any part of it into liquid.
4 Avoid pouring liquids on the main unit while cleaning.
5 Do not remain any solution on the surface after cleaning.
6 Only the body and cable of the probe are waterproof. Do not immerse the

probe socket into any liquid.

5.3 Disinfection

Clean the main unit and reusable accessories before they are disinfected. The validated
disinfectants for cleaning the main unit and reusable accessories are:
 Ethanol (75%)
 Isopropanol (70%)

5.3.1 Disinfection of the Main Unit

To disinfect the main unit, follow these steps:
1. Switch off the main unit.
2. Wipe the display screen using a soft, clean cloth dampened with the disinfectant

solution.
3. Wipe the exterior surface of the equipment using a soft cloth dampened with the

disinfectant solution.
4. Wipe off the disinfectant solution with a dry cloth after disinfection if necessary.
5. Dry the main unit for at least 30 minutes in a ventilated and cool place.

CAUTION
Pay attention not to immerse the probe socket into the disinfector.

5.3.2 Disinfection of the Probe

1. Disconnect the probe from the main unit.

2. Wear sterile protective gloves to prevent infection.

3. Clean and dry the transducer according to the methods in section 5.2.2 Cleaning of
the Probe.

4. Prepare the disinfectant solution (75% ethanol).

5. Spray the solution to the probe interface or wipe it with a sterile cloth dampened with
the disinfectant solution. Follow the disinfectant manufacturer's recommended
contact time and mode.

6. Rinse the probe according to the disinfectant instructions. Wipe the probe with a dry
sterile cloth or leave the probe to air dry.
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7. Inspect the probe to ensure that there is no damage.
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Chapter 6 Warranty and Service

6.1 Warranty

EDAN warrants that EDAN’s products meet the labeled specifications of the products
and will be free from defects in materials and workmanship that occur within warranty
period.

The warranty is void in cases of:

a) damage caused by mishandling during shipping.

b) subsequent damage caused by improper use or maintenance.

c) damage caused by alteration or repair by anyone not authorized by EDAN.

d) damage caused by accidents.

e) replacement or removal of serial number label and manufacture label.

If a product covered by this warranty is determined to be defective because of defective
materials, components, or workmanship, and the warranty claim is made within the
warranty period, EDAN will, at its discretion, repair or replace the defective part(s) free of
charge. EDAN will not provide a substitute product for use when the defective product is
being repaired.

6.2 Contact Information

If you have any question about maintenance, technical specifications or malfunctions of
devices, contact your local distributor.

Alternatively, you can send an email to EDAN service department at:
support@edan.com.

mailto:support@edan.com
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Appendix 1 Product Specifications

Product Name: Ultrasonic Pocket Doppler

Model:

SONOTRAX Lite, SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro,
SONOTRAX II, SONOTRAX II Pro, SONOTRAX Vascular

Safety:

Complies with: IEC 60601-1:2005+A1:2012, EN 60601-1:2006+A1:2013,
IEC 60601-1-2:2014, EN 60601-1-2:2015, IEC/EN 61266,

IEC/EN 60601-2-37

Classification:

Anti-electric
Shock Type: Internally powered equipment

Anti-electric
Shock Degree: Type B equipment

Degree of Protection against Harmful Ingress of Water:

Main Unit: Ordinary equipment (Sealed equipment without liquid
proof)

Probes:
IPX8 Water Ingress Protection Code, indicating this probe
does not get soaked under water within 1 meter deep for
five hours.

Degree of Safety
in Presence
of Flammable
Gases:

Equipment not suitable for use in presence of flammable
gases

Working System: Continuous running equipment

EMC: CISPR 11 Group 1 Class B (without power adapter)
CISPR 11 Group 1 Class A (with power adapter)

Physical Characteristic:

Main Unit

Size: 34 mm x 89 mm x 141 mm (Depth x Width x Height, ±1 mm)

Weight: <300 g (including the battery)

Probe

Weight: 100 g

Cable Length: 2.5 m

Size: 112 mm (diameter) x 32 mm (thickness)
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Environment:

Working:

Temperature: +5°C ~ +40°C ( +41ºF ~ +104ºF)

Humidity: 25%RH ~ 80% RH (non-condensing)

Atmospheric
Pressure:

86 kPa ~ 106 kPa

Transport and Storage:

Temperature: -20°C ~ +55°C (-4ºF ~ +131ºF)

Humidity: 25% RH ~ 93% RH (non-condensing)

Atmospheric
Pressure: 70 kPa ~106 kPa

Display:

45 mm x 25 mm LCD display

FHR Performance (Essential Performance):

FHR Measuring Range: 50 bpm ~ 210 bpm

Resolution: 1 bpm

Accuracy: ±3 bpm

Sensitivity: 10 weeks gestation (3 MHz)

Audio Output Power: 1 W

Recording and Playing:

Audio Sampling Frequency: 4 kHz

Recording Length: 240 seconds

White Backlight:

Two Brightness Adjustable: OFF, ON

Auto Shut down:

1 minute after no signal or operation, auto shut down

Recommended Battery Type:

Alkaline battery (AA LR6 1.5 V)

Rechargeable NI-MH battery (AA R6 1.2 V)

Ultrasonic Gel:

pH: 5.5~8.0

Acoustic Impedance: 1.5x106~1.7x106 Pa . s/m (in 35°C(95ºF))



SONOTRAX Series Ultrasonic Pocket Doppler User Manual Product Specifications

- 35 -

Stand-by Time (hour):

Model Alkaline Batteries Rechargeable
NI-MH Batteries

NI-MH Battery
Pack

SONOTRAX
Vascular

9 hr 8 hr

SONOTRAX Lite 9 hr 8 hr /

SONOTRAX Basic 9 hr 8 hr /

SONOTRAX Basic A 9 hr 8 hr /

SONOTRAX II / / 8 hr

SONOTRAX Pro 9 hr 8 hr /

SONOTRAX II Pro / / 8 hr

Rechargeable NI-MH Battery

Nominal Capacity: 1800 mAh

Nominal Voltage: 2.4 VDC

Continual Working Time: 8 hr

Necessary Charge Time: 4 hr

Ultrasound

Nominal Frequency

2.0 MHz Obstetrical Probe 2.0 MHz

3.0 MHz Obstetrical Probe 3.0 MHz

4.0 MHz Vascular Probe 4.0 MHz

5.0 MHz Vascular Probe 5.0 MHz

8.0 MHz Vascular Probe 8.0 MHz

Working Frequency

2.0 MHz Obstetrical Probe (2.0±10%) MHz

3.0 MHz Obstetrical Probe (3.0±10%) MHz

4.0 MHz Vascular Probe (4.0±10%) MHz

5.0 MHz Vascular Probe (5.0±10%) MHz

8.0 MHz Vascular Probe (8.0±10%) MHz

2.0 MHz/3.0 MHz
Obstetrical Probe p- < 1 MPa Iob < 10 mW/cm2 Ispta < 100 mW/cm2

4.0 MHz/5.0 MHz/8.0
MHz Vascular Probe p- < 1 MPa Iob < 50mW/cm2 Ispta < 100 mW/cm2
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Working Mode Continuous wave Doppler

Effective Radiating Area
of Transducer

2.0 MHz Obstetrical Probe (245±15%) mm2

3.0 MHz Obstetrical Probe (245±15%) mm2

4.0 MHz Vascular Probe (32±15%) mm2

5.0 MHz Vascular Probe (32±15%) mm2

8.0 MHz Vascular Probe (14±15%) mm2

Low Output Summary Table

(for systems with no transducers having global maximum index values exceeding 1.0)

System: SONOTRAX series Ultrasonic Pocket Doppler

Transducer
Model (MHz)

Ispta.3

(mW/cm2)
TI Type TI Value MI Isppa.3

(W/cm2)

CW 2.0 0.0563
TIS 0.0704

0.021 0.015
TIB 0.0113

CW 3.0 1.63
TIS 0.0116

0.0041 0.00163
TIB 0.0217

CW 4.0 20.24
TIS 0.0142

0.0125 0.02024
TIB 0.0589

CW 5.0 52.593
TIS 0.2055

0.01755 0.04972
TIB 0.3164

CW 8.0 110
TIS 0.24

0.022 0.11
TIB 0.41
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Appendix 2 Ordering Information

CAUTION

Only the parts supplied or recommended by the manufacturer should be used with
the Doppler.

Parts Part Number

Probe

2.0 MHz Obstetrical Probe 02.01.210326

3.0 MHz Obstetrical Probe 02.01.210327

4.0 MHz Vascular Probe 02.01.14346

5.0 MHz Vascular Probe 02.01.104822

8.0 MHz Vascular Probe 02.01.14347

Accessory

Alkaline Batteries 01.21.064086

Rechargeable NI-MH Batteries 21.21.064180

NI-MH Battery Pack 01.21.064182

Power Adapter
(American Standard) 02.01.214154

Power Adapter
(European Standard) 02.01.214155

Power Adapter
(Australian Standard) 02.01.214158

Power Adapter
(English Standard) 02.01.214156

Normal Carry case 01.56.465632
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Appendix 3 Troubleshooting

Phenomenon Possible Cause Solution

The speaker does not
sound.

The speaker is muted. Turn up the volume.

Bad connection between
the probe and main unit.

Make sure that the probe is
well connected to the main
unit.

Main board defective. Replace the main board.

Speaker defective. Replace the speaker.

Probe defective. Replace the probe.

The speaker sounds
weak.

The volume is too low. Turn up the volume.

No coupling gel is
applied.

Apply coupling gel on the
probe acoustic surface.

The battery is in low
energy.

Replace the battery or charge
the rechargeable battery.

Low sensitivity.

The probe is not placed at
the optimum position.

Locate the probe at a
position for optimal FHR
examining.

No coupling gel is
applied.

Apply coupling gel on the
probe acoustic surface.

The screen displays
nothing and the speaker
does not sound after the
main unit is switched on.

Main board defective. Replace the main board.

The battery is in low
energy.

Replace the battery or charge
the rechargeable battery.

The speaker sounds but
the screen displays
nothing or displays wrong
characters after the main
unit is switched on.

Main board defective. Replace the main board.

Screen defective. Replace the screen.

Loud noise.

The device is subject to
strong electromagnetic
emissions.

Make sure that the
environment in which the
device is operated is not
subject to any source of
strong electromagnetic
emissions.

Speaker defective. Replace the speaker.

Probe defective. Replace the probe.

Main board defective. Replace the main board.

The probe has not been
taken out from the probe
holder when the main unit
is switched on.

Take out the probe from the
probe holder before
switching on the main unit.

The battery is in low
energy.

Replace the battery or charge
the rechargeable battery.
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Too much coupling gel on
the probe acoustic
surface.

Wipe the residual coupling
gel off the probe after each
use.

The screen displays
nothing or displays
charge error when the
Doppler (SD3 PLUS or
SD3 PRO) is being
charged.

Power adapter defective. Replace the power adapter.

Battery defective. Replace the battery.

Main board defective. Replace the main board.

Charge stand defective. Replace the charge stand.
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Appendix 4 EMC Information

A4.1 Electromagnetic Emissions

For SONOTRAX Series Ultrasonic Pocket Doppler:

Guidance and manufacture’s declaration–electromagnetic emission

The SONOTRAX Series Ultrasonic Pocket Doppler is intended for use in the electromagnetic
environment specified below. The customer or the user of the device should assure that it is
used in such an environment.

Emission test Compliance Electromagnetic environment–guidance

RF emissions
CISPR 11 Group 1

The SONOTRAX Series Ultrasonic Pocket Doppler uses RF
energy only for its internal function. Therefore, its RF
emissions are very low and are not likely to cause any
interference in nearby electronic equipment.

RF emission
CISPR 11 Class B

The SONOTRAX Series Ultrasonic Pocket Doppler is
suitable for use in all establishments, including domestic
establishments and those directly connected to the public
low-voltage power supply network that supplies buildings
used for domestic purposes.

Harmonic
emissions
IEC/EN61000-3-2

Not applicable

Voltage
fluctuations
/flicker emissions
IEC/EN61000-3-3

Not applicable
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For SONOTRAX Series Ultrasonic Pocket Doppler with power adapter:

Guidance and manufacture’s declaration–electromagnetic emission

The SONOTRAX Series Ultrasonic Pocket Doppler with power adapter is intended for use in the
electromagnetic environment specified below. The customer or the user of the device should
assure that it is used in such an environment.

Emission test Compliance Electromagnetic environment–guidance

RF emissions
CISPR 11

Group 1

The SONOTRAX Series Ultrasonic Pocket Doppler with
power adapter uses RF energy only for its internal
function. Therefore, its RF emissions are very low and are
not likely to cause any interference in nearby electronic
equipment.

RF emission
CISPR 11

Class A

The SONOTRAX Series Ultrasonic Pocket Doppler with
power adapter is suitable for use in all establishments,
including domestic establishments and those directly
connected to the public low-voltage power supply network
that supplies buildings used for domestic purposes.

Harmonic
emissions
IEC/EN61000-3-2

Not applicable

Voltage
fluctuations
/flicker emissions
IEC/EN61000-3-3

Not applicable
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A4.2 Electromagnetic Immunity

For SONOTRAX Series Ultrasonic Pocket Doppler:

Guidance and manufacture’s declaration–electromagnetic immunity

The SONOTRAX Series Ultrasonic Pocket Doppler is intended for use in the electromagnetic
environment specified below. The customer or the user of the device should assure that it is
used in such an environment.

Immunity test
IEC 60601 test

level
Compliance

level
Electromagnetic

environment-guidance

Electrostatic
discharge (ESD)
IEC 61000-4-2

8 kV contact
15 kV air

8 kV contact
15 kV air

Floors should be wood,
concrete or ceramic tile. If
floor are covered with
synthetic material, the
relative humidity should be
at least 30%.

Electrical Fast
Transient/Burst
IEC/EN61000-4-4

±2 kV for power
supply lines Not applicable

Mains power quality should

be that of a typical

commercial or hospital

environment.

Surge
IEC/EN61000-4-5

±1 kV line(s) to line(s)
±2 kV line(s) to earth

Not applicable

Mains power quality should

be that of a typical

commercial or hospital

environment.

Voltage dips, short
interruptions, and
voltage variations
on power supply
input lines
IEC/EN61000-4-11

0 % UT; 0,5 cycle
At 0°, 45°, 90°, 135°,
180°, 225°, 270° and
315°

0 % UT; 1 cycle
and
70 % UT; 25/30
cycles )
Single phase: at 0°

0 % UT; 250/300
cycle

Not applicable Mains power quality should

be that of a typical

commercial or hospital

environment. If the user of

the SONOTRAX(2009)

Series requires continued

operation during power

mains interruptions, it is

recommended that the

SONOTRAX(2009) Series

be powered from an

uninterruptible power

supply or a battery.
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Power frequency
(50Hz/60Hz)
magnetic field
IEC61000-4-8

30 A/m 30 A/m

Power frequency magnetic

fields should be at levels

characteristic of a typical

location in a typical

commercial or hospital

environment.

For SONOTRAX Series Ultrasonic Pocket Doppler with power adapter:

Guidance and manufacture’s declaration–electromagnetic immunity

The SONOTRAX Series Ultrasonic Pocket Doppler with power adapter is intended for use in the
electromagnetic environment specified below. The customer or the user of the device should
assure that it is used in such an environment.

Immunity test
IEC 60601 test

level
Compliance

level
Electromagnetic

environment-guidance

Electrostatic
discharge (ESD)
IEC 61000-4-2

8 kV contact
15 kV air

8 kV contact
15 kV air

Floors should be wood,
concrete or ceramic tile. If
floor are covered with
synthetic material, the
relative humidity should be
at least 30%.

Electrical Fast
Transient/Burst
IEC/EN61000-4-4

±2 kV for power
supply lines

±2 kV for power
supply lines

Mains power quality should

be that of a typical

commercial or hospital

environment.

Surge
IEC/EN61000-4-5

±1 kV line(s) to line(s)
±2 kV line(s) to earth

±1 kV line(s) to
line(s)

Mains power quality should

be that of a typical

commercial or hospital

environment.

Voltage dips, short
interruptions, and
voltage variations
on power supply
input lines
IEC/EN61000-4-11

0 % UT; 0,5 cycle
At 0°, 45°, 90°, 135°,
180°, 225°, 270° and
315°

0 % UT; 1 cycle
and
70 % UT; 25/30
cycles )
Single phase: at 0°

0 % UT; 0,5 cycle
At 0°, 45°, 90°,
135°, 180°, 225°,
270° and 315°

0 % UT; 1 cycle
and
70 % UT; 25/30
cycles )
Single phase: at 0°

Mains power quality should

be that of a typical

commercial or hospital

environment. If the user of

the SONOTRAX(2009)

Series with power adapter
requires continued

operation during power

mains interruptions, it is

recommended that the

SONOTRAX(2009) Series



SONOTRAX Series Ultrasonic Pocket Doppler User Manual EMC Information

- 44 -

0 % UT; 250/300
cycle

0 % UT; 250/300

cycle

with power adapter be

powered from an

uninterruptible power

supply or a battery.

Power frequency
(50Hz/60Hz)
magnetic field
IEC61000-4-8

30 A/m 30 A/m

Power frequency magnetic

fields should be at levels

characteristic of a typical

location in a typical

commercial or hospital

environment.

A4.3 Electromagnetic Immunity

Guidance and manufacture’s declaration – electromagnetic immunity

The SONOTRAX Series Ultrasonic Pocket Doppler is intended for use in the electromagnetic
environment specified below. The customer or the user of the device should assure that it is
used in such an environment.

Immunity test IEC 60601 test level
Compliance

level
Electromagnetic

environment-guidance

Conducted RF
IEC61000-4-6

Radiated RF
IEC61000-4-3

3 Vrms
150 kHz ~ 80 MHz
6Vrmsc)in ISM bands
between
0,15 MHz and 80
MHz

3V/m
80 MHz ~ 2.7 GHz

3 Vrms
150 kHz to 80
MHz
6Vrmsc)in
ISM bands
between
0,15 MHz and
80 MHz

3 V/m
80 MHz to 2.7
GHz

Portable and mobile RF
communications equipment should be
used no closer to any part of the
SONOTRAX Series Ultrasonic Pocket
Doppler, including cables, than the
recommended separation distance
calculated from the equation
applicable to the frequency of the
transmitter.
Recommended separation distance:

Pd 2.1 150 kHz to 80 MHz
Pd 2.1 80 MHz to 800 MHz
Pd 3.2 800 MHz to 2.7 GHz

E/6 Pd  at RF wireless
communications equipment bands
(Portable RF communications
equipment (including peripherals such
as antenna cables and external
antennas) should be used no closer
than 30 cm (12 inches) to any part of
the SONOTRAX Series Ultrasonic
Pocket Doppler, including cables
specified by the manufacturer).
Where P is the maximum output
power rating of the transmitter in watts
(W) according to the transmitter
manufacturer and d is the
recommended separation distance in
metres (m).
Field strengths from fixed RF
transmitters, as determined by an
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electromagnetic site survey,a should
be less than the compliance level in
each frequency range.b
Interference may occur in the vicinity
of equipment marked with the

following symbol:

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies.
NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is
affected by absorption and reflection from structures, objects and people.

a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless)
telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV
broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic
environment due to fixed RF transmitters, an electromagnetic site survey should be
considered. If the measured field strength in the location in which the SONOTRAX Series
Ultrasonic Pocket Doppler is used exceeds the applicable RF compliance level above, the
SONOTRAX Series Ultrasonic Pocket Doppler should be observed to verify normal
operation. If abnormal performance is observed, additional measures may be necessary,
such as reorienting or relocating the SONOTRAX Series Ultrasonic Pocket Doppler.

b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
c The ISM (industrial, scientific and medical) bands between 0,15 MHz and 80 MHz are 6,765

MHz to6,795 MHz; 13,553 MHz to 13,567 MHz; 26,957 MHz to 27,283 MHz; and 40,66 MHz
to 40,70 MHz. The amateur radio bands between 0,15 MHz and 80 MHz are 1,8 MHz to 2,0
MHz, 3,5 MHz to 4,0 MHz, 5,3 MHz to 5,4 MHz, 7 MHz to 7,3 MHz, 10,1 MHz to 10,15 MHz,
14 MHz to 14,2 MHz, 18,07 MHz to 18,17 MHz,21,0 MHz to 21,4 MHz, 24,89 MHz to 24,99
MHz, 28,0 MHz to 29,7 MHz and 50,0 MHz to 54,0 MHz.

Table-Test specifications for ENCLOSURE PORT IMMUNITY to RF wireless
communications equipment

Test
Frequency
(MHz)

Brand a)
(MHz) Service a)

Modulation
b)

Maximum
Power(W)

Distanc
e (m)

IMMUNITY TEST
LEVEL (V/m)

385 380-390 TETRA 400
Pulse
modulation
b) 18Hz

1.8 0.3 27

450 430-470
GMRS
460, FRS
460

FM C)

2 0.3 28±5 kHz
deviation
1kHz sine

710

704-787
LTE Brand
13, 17

Pulse
modulation
b) 217 Hz

0.2 0.3 9745

780

810

800-960

GSM
800/900,T
ETRA 800,
iDEN 820,
CDMA
850, LTE
Band 5

Pulse
modulation
b) 18 Hz

2 0.3 28

870

930
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1720
1700-199
0

GSM 1800;
CDMA
1900; GSM
1900;
DECT; LTE
Band 1, 3,
4,25;
UMTS

Pulse
modulation
b) 217 Hz

2 0.3 28

1845

1970

2450
2400-257
0

Bluetooth,
WLAN,802
.11 b/g/n,
RFID 2450,
LTE Brand
7

Pulse
modulation
b) 217 Hz

2 0.3 28

5240
5100-580
0

WLAN
802.11 a/n

Pulse
modulation
b) 217 Hz

0.2 0.3 95500

5785
Note: If necessary to achieve the IMMUNITY TEST LEVEL, the distance between the transmitting
antenna and the ME EQUIPMENT or ME SYSTEM maybe reduce to 1m. The 1 m test distance is
permitted by IEC 61000-4-3.

a) For some services, only the uplink frequencies are included.
b) The carrier shall be modulated using a 50% duty cycle square wave signal.
c) As an alternative FM modulation, 50% pulse modulation at 18 Hz may be used because while
it does not represent actual modulation, it would be worst case

A4.4 Recommended Separation Distances

Recommended separation distances between portable and mobile RF communications
equipment and the SONOTRAX Series Ultrasonic Pocket Doppler

The SONOTRAX Series Ultrasonic Pocket Doppler is intended for use in an electromagnetic
environment in which radiated RF disturbances are controlled. The customer or the user of the
device can help prevent electromagnetic interference by maintaining a minimum distance between
portable and mobile RF communications equipment (transmitters) and the SONOTRAX Series
Ultrasonic Pocket Doppler as recommended below, according to the maximum output power of the
communications equipment.

Rated
maximum

output power
of transmitter

(W)

Separation distance according to frequency of transmitter (m)

150 kHz to 80
MHz

Pd 2.1

80 MHz to 800 MHz

Pd 2.1
800 MHz to 2.7 GHz

Pd 3.2

0.01 0.12 0.12 0.23

0.1 0.38 0.38 0.73

1 1.2 1.2 2.3

10 3.8 3.8 7.3

100 12 12 23
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For transmitters rated at a maximum output power not listed above, the recommended separation
distance d in meters (m) can be estimated using the equation applicable to the frequency of the
transmitter, where P is the maximum output power rating of the transmitter in watts (W) according to
the transmitter manufacturer.

NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.
NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected
by absorption and reflection from structures, objects and people.
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Appendix 5 Ultrasound Intensity and Safety

A5.1 Ultrasound in Medicine

The use of diagnostic ultrasound has proved to be a valuable tool in medical practice.
Given its known benefits for non-invasive investigations and medical diagnosis,
including investigation of the human fetus, the question of clinical safety with regards to
ultrasound intensity arises.

There is no easy answer to the question of safety surrounding the use of diagnostic
ultrasound equipment. Application of the ALARA (As Low As Reasonably Achievable)
principle serves as a rule-of-thumb that will help you to get reasonable results with the
lowest possible ultrasonic output.

The American Institute of Ultrasound in Medicine (AIUM) states that given its track
record of over 25 years of use and no confirmed biological effects on patients or
instrument operators, the benefits of the prudent use of diagnostic ultrasound clearly
outweigh any risks.

A5.2 Ultrasound Safety and the ALARA Principle

Ultrasound waves dissipate energy in the form of heat and can therefore cause tissue
warming. Although this effect is extremely low with Doppler, it is important to know how
to control and limit patient exposure. Major governing bodies in ultrasound have issued
statements to the effect that there are no known adverse effects from the use of
diagnostic ultrasound, however, exposure levels should always be limited to As Low As
Reasonably Achievable (the ALARA principle).

A5.3 Explanation of MI/TI

A5.3.1 MI (Mechanical Index)

Cavitations will be generated when ultrasound wave passes through and contacts
tissues, resulting in instantaneous local overheating. This phenomenon is determined by
acoustic pressure, spectrum, focus, transmission mode, and factors such as states and
properties of the tissue and boundary. This mechanical bioeffect is a threshold
phenomenon that occurs when a certain level of ultrasound output is exceeded. The
threshold is related to the type of tissue. Although no confirmed adverse mechanical
effects on patients or mammals caused by exposure at intensities typical of present
diagnostic ultrasound instruments have ever been reported, the threshold for cavitation
is still undetermined. Generally speaking, the higher the acoustic pressure, the greater
the potential for mechanical bioeffects; the lower the acoustic frequency, the greater the
potential for mechanical bioeffects.

The AIUM and NEMA formulate mechanical index (MI) in order to indicate the potential
for mechanical effects. The MI is defined as the ratio of the peak-rarefactional acoustic
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pressure (should be calculated by tissue acoustic attenuation coefficient 0.3dB/cm/MHz)
to the acoustic frequency.

MI = Pr, α

fawf × CMI

CMI = 1 (MPa / MHz )

A5.3.2 TI (Thermal Index)

Heating of tissues is caused by absorption of ultrasound when the ultrasound energy is
applied. The temperature rise is determined by the acoustic intensity, exposed area and
thermophysical properties of the tissue.

In order to indicate the potential for temperature rise caused by thermal effects, the
AIUM and NEMA formulate thermal index (TI). It is defined as the ratio of the total
acoustic power to the acoustic power required to raise the tissue temperature by 1ºC
(1.8°F).

According to different thermophysical properties of the tissue, TI is divided into three
kinds: TIS, TIB and TIC.

TIS (Soft Tissue Thermal Index): It provides an estimate of potential temperature rise in
soft or similar tissues.

TIB (Bone Thermal Index): It provides an estimate of potential temperature rise when the
ultrasound beam passes through soft tissue and a focal region is in the immediate
vicinity of bone.

TIC (Cranial Bone Thermal Index): It provides an estimate of potential temperature rise in
the cranial bones or superficial bones.

A5.3.3 Measurement Uncertainties

The uncertainties in the measurements were predominantly systematic in origin; the
random uncertainties were negligible in comparison. The overall systematic
uncertainties were determined as follows:

1. Hydrophone Sensitivity: ±23 percent for intensity, ±11.5 percent for pressure.
Based on the hydrophone calibration report by ONDA. The uncertainty was
determined within ±1 dB in frequency range 1-15 MHz.

2. Digitizer: ±3 percent for intensity. ±1.5 percent for pressure.
Based on the stated accuracy of the 8-bit resolution of the Agilent DSO6012
Digital Oscilloscope and the signal-to-noise ratio of the measurement.

3. Temperature: ±1 percent
Based on the temperature variation of the water bath of ±1ºC (1.8°F).

4. Spatial Averaging: ±10 percent for intensity, ±5 percent for pressure.

5. Non-linear Distortion: N/A.
No effects of nonlinear propagation were observed.

Since all the above error sources are independent, they may be added on an RMS basis,
giving a total uncertainty of ±25.1 percent for all intensity values reported, ±12.7 percent
for all the pressure values and ±12.6 percent for the Mechanical Index.
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A5.4 Prudent Use Statement

Although no confirmed bioeffects on patients caused by exposure from present
diagnostic ultrasound equipment have ever been reported, the potential exists that such
bioeffects may be identified in the future. Therefore, the ultrasound should be used
prudently. High levels of acoustic output and long exposure time should be avoided
while acquiring necessary clinical information.

A5.5 References for Acoustic Output and Safety

1. "Bioeffects and Safety of Diagnostic Ultrasound" issued by AIUM in 1993

2. "Medical Ultrasound Safety" issued by AIUM in 1994

3. "Acoustic Output Measurement Standard for Diagnostic Ultrasound Equipment,

Revision 3" issued by AIUM/NEMA in 2004

4. "Standard for real-time display of thermal and mechanical acoustic output indices on

diagnostic ultrasound equipment, Revision 2" issued by AIUM/NEMA in 2004

5. "Information for Manufacturers Seeking Marketing Clearance of Diagnostic

Ultrasound Systems and Transducers" issued in 2008.

6. "Medical electrical equipment—Part 2-37: Particular requirements for the basic
safety and essential performance of ultrasonic medical diagnostic and monitoring
equipment" issued by IEC in 2007.

A5.6 Probe Acoustic Output Parameters List
Acoustic output reporting table for IEC60601-2-37
(IEC60601-2-37, Edition 2.1, 2015-06, table 201.103)

System:SONOTRAX Lite
Transducer Model: SONOTRAX CW2.0
Working Mode:CW mode
Working Frequency:2.0MHz

Index label MI TIS TIB TIC
At
surface

Below
surface

At
surface

Below
surface

Maximum index value 0.021 0.070 0.011 N/A
Index component value N/A 0.070 N/A 0.011
Acoustic
Parameters

pr.αat zMI (MPa) 0.031
P (mW) 11.80 11.80 N/A
P1x1 (mW) N/A N/A
zs (cm) 2.90
zb (cm) 3.45
zMI (cm) 3.50
zPII.α (cm) 3.50
fawf (MHz) 2.18 2.18 2.18 N/A

Other
Information

prr (Hz) N/A
srr (Hz) N/A
npps N/A
Ipa.α at zPII.α (W/cm2) 0.015



SONOTRAX Series Ultrasonic Pocket Doppler User Manual Ultrasound Intensity and Safety

- 51 -

Ispta.α at zPII.α or
zSII.α(mW/cm2)

0.056

Ispta at zPII or zSII (mW/cm2) 0.091
pr. at zPII (MPa) 0.057

Operating
control
conditions

Focus(mm) Fixed
Depth(mm) Fixed

Frequency(MHz) 2.00

Acoustic Output Reporting Table for Track 1
Non-scanning Mode

System: SONOTRAX Operating Mode: CW mode
Transducer: CD2.0 Working Frequency: 2.0 MHz

Acoustic Output MI
Ispta.3

(mW/cm2)
Isppa.3

(W/cm2)

Global Maximum Value 0.021 0.0563 0.015

Associated
Acoustic Parameter

Pr.3 (MPa) 0.031

W0 (mW) 11.8 11.8

fc (MHz) 2.18 2.18 2.18

Zsp (cm) 1.85 1.85 1.85

Beam
dimensions

X-6 (cm) 0.915 0.915

Y-6 (cm) 1.922 1.922

PD (µsec) CW CW

PRF (Hz) N/A N/A

EBD
Az. (cm) 2.50

Ele. (cm) 1.25

Operating Control
Conditions

Fixed

Acoustic output reporting table for IEC60601-2-37
(IEC60601-2-37, Edition 2.1, 2015-06, table 201.103)

System:SONOTRAX Lite
Transducer Model: SONOTRAX CW3.0
Working Mode:CW mode
Working Frequency:3.0MHz

Index label MI TIS TIB TIC
At
surface

Below
surface

At
surface

Below
surface

Maximum index value 0.0041 0.012 0.022 N/A
Index component value N/A 0.012 N/A 0.022
Acoustic
Parameters

pr.αat zMI (MPa) 0.0070
P (mW) 1.20 1.20 N/A
P1x1 (mW) N/A N/A
zs (cm) 2.90
zb (cm) 3.90
zMI (cm) 4.00
zPII.α (cm) 4.00
fawf (MHz) 3.00 3.00 3.00 N/A

Other
Information

prr (Hz) N/A
srr (Hz) N/A
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npps N/A
Ipa.α at zPII.α (W/cm2) 0.0016
Ispta.α at zPII.α or
zSII.α(mW/cm2)

1.63

Ispta at zPII or zSII (mW/cm2) 2.91
pr. at zPII (MPa) 0.013

Operating
control
conditions

Focus(mm) Fixed
Depth(mm) Fixed

Frequency(MHz) 3.00
Acoustic Output Reporting Table for Track 1

Non-scanning Mode
System: SONOTRAX Operating Mode: CW mode
Transducer: CD3.0 Working Frequency: 3.0 MHz

Acoustic Output MI
Ispta.3

(mW/cm2)
Isppa.3

(W/cm2)

Global Maximum Value 0.0041 1.63 0.00163

Associated
Acoustic Parameter

Pr.3 (MPa) 0.007

W0 (mW) 1.2 1.2

fc (MHz) 3.0 3.0 3.0

Zsp (cm) 2.35 2.35 2.35

Beam
dimensions

X-6 (cm) 1.7 1.7

Y-6 (cm) 0.532 0.532

PD (µsec) CW CW

PRF (Hz) N/A N/A

EBD
Az. (cm) 1.11

Ele. (cm) 2.22

Operating Control
Conditions

Fixed

Acoustic output reporting table for IEC60601-2-37
(IEC60601-2-37, Edition 2.1, 2015-06, table 201.103)

System:SONOTRAX Lite
Transducer Model: SONOTRAX CD4.0
Working Mode:CW mode
Working Frequency:4.0MHz

Index label MI TIS TIB TIC
At
surface

Below
surface

At
surface

Below
surface

Maximum index value 0.013 0.014 0.059 N/A
Index component value 0.014 N/A N/A 0.059
Acoustic
Parameters

pr.αat zMI (MPa) 0.025
P (mW) 0.75 0.75 N/A
P1x1 (mW) N/A N/A
zs (cm) 1.30
zb (cm) 1.30
zMI (cm) 1.40
zPII.α (cm) 1.40
fawf (MHz) 4.00 4.00 4.00 N/A

Other
Information

prr (Hz) N/A
srr (Hz) N/A



SONOTRAX Series Ultrasonic Pocket Doppler User Manual Ultrasound Intensity and Safety

- 53 -

npps N/A
Ipa.α at zPII.α (W/cm2) 0.020
Ispta.α at zPII.α or
zSII.α(mW/cm2)

20.24

Ispta at zPII or zSII (mW/cm2) 36.51
pr. at zPII (MPa) 0.045

Operating
control
conditions

Focus(mm) Fixed
Depth(mm) Fixed

Frequency(MHz) 4.00
Acoustic Output Reporting Table for Track 1

Non-scanning Mode
System: SONOTRAX Operating Mode: CW mode
Transducer: CD4.0 Working Frequency: 4.0 MHz

Acoustic Output MI
Ispta.3

(mW/cm2)
Isppa.3

(W/cm2)

Global Maximum Value 0.0125 20.24 0.02024

Associated
Acoustic Parameter

Pr.3 (MPa) 0.0249

W0 (mW) 0.746 0.746

fc (MHz) 4.0 4.0 4.0

Zsp (cm) 0.975 0.975 0.975

Beam
dimensions

X-6 (cm) 0.142 0.142

Y-6 (cm) 0.206 0.206

PD (µsec) CW CW

PRF (Hz) N/A N/A

EBD
Az. (cm) 0.45

Ele. (cm) 0.9

Operating Control
Conditions

Fixed

Acoustic output reporting table for IEC60601-2-37
(IEC60601-2-37, Edition 2.1, 2015-06, table 201.103)

System:SONOTRAX Lite
Transducer Model: SONOTRAX CD5.0
Working Mode:CW mode
Working Frequency:5.0MHz

Index label MI TIS TIB TIC
At
surface

Below
surface

At
surface

Below
surface

Maximum index value 0.018 0.21 0.32 N/A
Index component value 0.21 N/A N/A 0.32
Acoustic
Parameters

pr.αat zMI (MPa) 0.039
P (mW) 8.65 8.65 N/A
P1x1 (mW) N/A N/A
zs (cm) 2.30
zb (cm) 2.30
zMI (cm) 3.00
zPII.α (cm) 3.00
fawf (MHz) 5.00 5.00 5.00 N/A

Other
Information

prr (Hz) N/A
srr (Hz) N/A
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npps N/A
Ipa.α at zPII.α (W/cm2) 0.050
Ispta.α at zPII.α or
zSII.α(mW/cm2)

52.59

Ispta at zPII or zSII (mW/cm2) 91.26
pr. at zPII (MPa) 0.066

Operating
control
conditions

Focus(mm) Fixed
Depth(mm) Fixed

Frequency(MHz) 5.00
Acoustic Output Reporting Table for Track 1

Non-scanning Mode
System: SONOTRAX Operating Mode: CW mode
Transducer: CD5.0 Working Frequency: 5.0 MHz

Acoustic Output MI
Ispta.3

(mW/cm2)
Isppa.3

(W/cm2)

Global Maximum Value 0.01755 52.593 0.04972

Associated
Acoustic Parameter

Pr.3 (MPa) 0.03925

W0 (mW) 8.648 8.648

fc (MHz) 4.99999 4.99999 4.99999

Zsp (cm) 1.2 1.2 1.2

Beam
dimensions

X-6 (cm) 0.2484 0.2484

Y-6 (cm) 0.4534 0.4534

PD (µsec) CW CW

PRF (Hz) N/A N/A

EBD
Az. (cm) 0.4

Ele. (cm) 0.8

Operating Control
Conditions

Fixed

Acoustic output reporting table for IEC60601-2-37
(IEC60601-2-37, Edition 2.1, 2015-06, table 201.103)

System:SONOTRAX Lite
Transducer Model: SONOTRAX CD8.0
Working Mode:CW mode
Working Frequency: 8.0MHz

Index label MI TIS TIB TIC
At
surface

Below
surface

At
surface

Below
surface

Maximum index value 0.022 0.24 0.41 N/A
Index component value 0.24 N/A N/A 0.41
Acoustic
Parameters

pr.αat zMI (MPa) 0.063
P (mW) 6.19 6.19 N/A
P1x1 (mW) N/A N/A
zs (cm) N/A
zb (cm) 0.65
zMI (cm) 0.56
zPII.α (cm) 0.56
fawf (MHz) 8.00 8.00 8.00 N/A

Other
Information

prr (Hz) N/A
srr (Hz) N/A
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npps N/A
Ipa.α at zPII.α (W/cm2) 0.11
Ispta.α at zPII.α or
zSII.α(mW/cm2)

110.00

Ispta at zPII or zSII

(mW/cm2)
149.40

pr. at zPII (MPa) 0.073

Operating
control
conditions

Focus(mm) Fixed Fixed N/A N/A Fixed N/A
Depth(mm) Fixed Fixed N/A N/A Fixed N/A

Frequency(MHz) 8.00 8.00 N/A N/A 8.00 N/A
Acoustic Output Reporting Table for Track 1

Non-scanning Mode
System: SONOTRAX Operating Mode: CW mode
Transducer: CD8.0 Working Frequency: 8.0 MHz

Acoustic Output MI
Ispta.3

(mW/cm2)
Isppa.3

(W/cm2)

Global Maximum Value 0.022 110 0.11

Associated
Acoustic Parameter

Pr.3 (MPa) 0.063

W0 (mW) 6.19 6.19

fc (MHz) 8.0 8.0 8.0

Zsp (cm) 0.65 0.65 0.65

Beam
dimensions

X-6 (cm) 0.298 0.298

Y-6 (cm) 0.16 0.16

PD (µsec) CW CW

PRF (Hz) N/A N/A

EBD
Az. (cm) 0.3

Ele. (cm) 0.6

Operating Control
Conditions

Fixed
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Appendix 6 Overall Sensitivity

Diameter of
Target Reflector

(mm)

Distance
(d)(mm)

A(dB)

Two-way Attenuation
B=∑Ba+Bw VS(r.m.s)

mV
Vn(r.m.s)

mV

 
 











...

...log20 10 smrV
smrVC

n

s

dB

Overall
Sensitivity

(S=A(d)+B+C)
dB

∑B (T: ultrasonic attenuation
phantom No. Ba:dB)

Bw

(dB)
B

(dB)

1.58
A=45.7dB@

2 MHz

50 45.7
T 6# 6# 3# -

0 57.5 72.15 34.32 6.45 109.6
Ba 24.9 24.9 7.7 -

75 45.7
T 6# 6# 2# -

0 55.3 70.35 34.83 6.10 107.1
Ba 24.9 24.9 5.5 -

100 45.7
T 6# 6# 1# -

0 53.5 72.62 35.64 6.30 105.5
Ba 24.9 24.9 3.7 -

200 45.7
T 6# 6# - -

0 49.8 75.47 35.86 6.24 101.7
Ba 24.9 24.9 - -

2.38
A=43.2dB@

2 MHz

50 43.2
T 6# 6# 2# 1#

0 59.0 72.36 34.38 6.46 108.6
Ba 24.9 24.9 5.5 3.7

75 43.2
T 6# 6# 3# -

0 57.5 74.31 34.83 6.58 107.2
Ba 24.9 24.9 7.7 -

100 43.2
T 6# 6# 2# -

0 55.3 75.26 35.62 6.49 104.9
Ba 24.9 24.9 5.5 -

200 43.2
T 6# 6# 1# -

0 53.5 75.42 35.83 6.45 103.2
Ba 24.9 24.9 3.7 -

Doppler Frequency (Hz) 333
Velocity of Target

(cm/s)
12.5
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Diameter of
Target Reflector

(mm)

Distance
(d)(mm)

A(dB)

Two-way Attenuation
B=∑Ba+Bw

VS(r.m.s)
mV

Vn(r.m.s)
mV

 
 











...

...log20 10 smrV
smrVC

n

s

dB

Overall
Sensitivity

(S=A(d)+B+C)
dB

∑B (T: ultrasonic attenuation
phantom No. Ba:dB)

Bw

(dB)
B

(dB)

1.58
A=44.5dB@

3 MHz

50 44.5
T 6# 3# - -

0 57.1 112.3 52.44 6.61 108.2
Ba 43.6 13.5 - -

75 44.5
T 6# 3# - -

0 57.1 108.4 52.28 6.34 107.9
Ba 43.6 13.5 - -

100 44.5
T 6# 3# - -

0 57.1 113.8 54.56 6.39 107.9
Ba 43.6 13.5 - -

200 44.5
T 6# 3# - -

0 57.1 112.2 54.82 6.22 103.3
Ba 43.6 13.5 - -

2.38
A=42.0dB@

3 MHz

50 42.0
T 6# 3# - -

0 57.1 109.0 53.46 6.18 105.2
Ba 43.6 13.5 - -

75 42.0
T 6# 3# - -

0 57.1 113.8 52.43 6.73 105.8
Ba 43.6 13.5 - -

100 42.0
T 6# 3# - -

0 57.1 110.4 54.35 6.16 105.2
Ba 43.6 13.5 - -

200 42.0
T 6# 3# - -

0 57.1 112.7 54.46 6.32 105.4
Ba 43.6 13.5 - -

Doppler Frequency (Hz) 500 Velocity of Target
(cm/s)

12.5




